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1 Introduction

1.1 What is WinPLC7-Analyzer?

WinPLC7-Analyzer is a PLC-analyzer for S5 and S7 controllers.
The analyzer can record certain statuses that occur in a PLC (operand statuses).

The status of the following operands can be recorded:

Inputs (bit/byte/word/double word)
Outputs (bit/byte/word/double word)
Peripheral inputs (byte/word/double word)
Flags (bit/byte/word/double word)
Data from a data block (bit/byte/word/double word)
Timers
Counters

A recording can also be controlled by triggers that depend on operands or timers.
Cyclic exact recording is supported by S7 controllers.

The trend of a signal can be assessed while it is being recorded.  
The waveforms of operands are displayed in graphical form so their relationships are
easily recognized.
When you have connected a suitable modem (see menu item Help->Display a list of
compatible SMS-modems) the software can send an SMS to inform service staff
immediately when a problem is detected.

Several search functions are available to simplify the evaluation of the signals that are
related to the operands.

1.2 Applications

WinPLC7-Analyzer is an invaluable tool to assist anybody who is concerned with
commissioning of plant and machinery.

Possible applications include:

Sporadic troubleshooting of machines and facilities
Process optimization
Tool required for commissioning, e.g. wiring checks
Fault reports by means of SMS
Comparison of planned and actual recordings from the plant 
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1.3 Which controllers are supported by the analyzer?

The following controllers are supported:

S7 controllers

Simatic® S7-300®

Simatic® S7-400®

Simatic® S7-1200®

Simatic® S7-1500®

VIPA System 100V, VIPA System 200V, VIPA System 300V, VIPA System 500V
Other controllers compatible with S7 controllers

S5 controllers

Simatic® S5-90U
Simatic® S5-95U
Simatic® S5-100U, Simatic® S5-101U
Simatic® S5-115U, Simatic® S5-135U, Simatic® S5-155U

Note: S5 controllers do not permit cyclic exact recording.

The drivers required for these controllers have already been implemented in the
software.

1.4 Which drivers are supplied with the analyzer?

Drivers for S7 controllers

MPI adapter serial
MPI adapter USB (with a virtual COM-port)
MHJ-Netlink for MPI or Profibus connection
Netlink-PRO for MPI or Profibus connection
Ethernet (provided that the PLC has an Ethernet interface)
Simatic® Net Hardware like CP5512, CP5611, SIEMENS USB Adapter, ...).
It's only possible to use this driver if the Simatic® Net drivers are installed on your
computer. For example if SIEMENS STEP7 or SIEMENS Prodave is already
installed on your computer.

Drivers for S5 controllers

AS511 (PG socket via S5 adapter cable)
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1.5 Terms and abbreviations

This manual uses the following terms and abbreviation:

PLC Programmable Logical Controller. This refers to an S5 or an
S7 controller.

CPU The term CPU always refers to the CPU that is contained in
the PLC.

S5 Simatic® S5
S7 Simatic® S7
Operand This refers to an address in the PLC. Possible operands are:

I5.7, MB10, MD50, etc.
Project This refers to a WinPLC-Analyzer project
Signal Recording or value of an operand
Signal window A summary of multiple operands in a single  logging window
Controller This refers to the connected PLC
MPI Multiple-Protocol-Interface. This refers to the  programming

interface of the S7 controller (PLC)
RS232 The serial interface of a PC
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1.6 New features in version 2 of WinPLC7-Analyzer

The new features are:

WinPLC7-Analyzer can now use installed Simatic® Net driver to use CPU5512,
CP5611 and more devices from SIEMENS.
The Simatic® Net are installed if STEP®7 V5.x or Prodave is installed on your
system.
If you use WinPLC7-Analyzer on a SIEMENS PG you can also use this new
feature.
You can use the Simatic® Net driver with the new connection way "S7-Simatic
Net" in WinPLC7-Analyzer.
The new interface "Netlink PRO" is now supported.
There exist a new connection way: "S7-Netlink-PRO"
You can start the recording, even if the PLC is in STOP mode.
If the PLC go to STOP mode the I stack and the B stack will be saved in a log file.
So you examine the reason for the STOP mode. You can view the I stack with
the system message dialog.
For more information read capter 12.8 "Evaluations of the system messages". 

1.7 New features in version 3 of WinPLC-Analyzer

New recording type: Offline-recording.
With the offline-recording you can record "scan exact" and also "cyclic exact".
While the recording you can disconnect the computer. Within the PLC the
recording procedure is still working until the allocated memory of the PLC is full.
With this recording type it is also possible to use various trigger (Time-trigger,
recording trigger).
In the "scan exact" recording type it is possible to save "snapshots" to the hard
drive. A snapshot is a range of operands (exampe: MB0 to MB100) that are
stored to the hard drive when the snapshot event comes up. So you can save  
and view additional informations in specific situations.
The representation of the signals can be change to "Standard" or "Small".  With
this you can view more signals per screen.
Improvements in the dialog "Start recording". Now you can see the status of the
LEDs on the PLC module: RUN, STOP, SF, BF1, BF2. So you can see at once if
a error LED is ON.
New dialog Tools->Settings. In this dialog you can define your preferred
representation, color and line width.
New menu items in the context menu of the signal window:
- All signals: Standard representation
- Alle signals: Small representation
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2 Installation

2.1 System requirements

PC with a min. CPU clock rate of 500 MHz
Windows XP
Windows Vista
Windows 7 (32 and 64 Bit)
Windows 8 (32 and 64 Bit)
512 MB free RAM
1 GB of free space on the hard disk to save recorded signals

You can implement the PC-PLC connection by means of the following hardware:

MPI-PC adapter serial
MPI-PC adapter USB (using a virtual COM port)
MHJ-Netlink (MPI or Profibus)
Netlink-PRO (MPI or Profibus)
Standard network adapter (subject to the PLC having an Ethernet interface)
Driver for original SIEMENS adapters (CP5512, CP5611, SIEMENS USB
adapter, ...).
If Simatic® Net is installed on your system, you can also use SIEMENS MPI
adapter with WinPLC7-Analyzer.
Simatic® Net is automatically installed on your system if STEP®7 V5.x or Prodave
is installed. 
For S5 controllers: standard S5 cabling

2.2 Installation

Start the installation routine and follow the instructions displayed on-screen.  
When the installation completes a start icon is placed on the desktop.  
You can also find a start icon and a PDF file containing this user guide in the program
group of WinPLC7-Analyzer.

2.3 Uninstalling

The program group of WinPLC7-Analyzer also contains an icon that you can use to
uninstall the software.
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3 Caution - danger

Please remember the following information when using the software:

The recording of operand statuses places an additional load on the CPU of the
PLC. This will cause a marginal increase in the cycle time of the PLC program.
A small subroutine is required in the controller to perform cyclic exact recording.
This program must be transferred to the controller when the recording is started.
The code will be removed automatically after recording has been completed.
These additional statements also increase the cycle time of the PLC.
For CPUs running close to maximum capacity this means that the CPU could go
to STOP mode when the cycle time is exceeded.
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4 Getting started

The "Getting started" chapter is intended for those users who wish to start immediately.
Here you find step-by-step instructions that you can follow easily.  
Triggers are not described in the "Getting started" chapter. Please refer to the chapter
"Recording PLC statuses" if you require details.

4.1 Generating a new project

You can only start a recording within a project. For this reason you must generate a new
project or open an existing project.
You can do this by means of the menu "File->Open, generate project".
Select this menu item and click the "New Project" button.
An input dialog will be displayed. Enter the name for the project into this dialog.
You can enter a name, e.g. "Plant18". The entered name can contain spaces.
Click OK when you have completed the new project name.

Fig.: New project with no signal windows

In order to start recording you must first generate a signal window. Select menu item
"File->New signal window" and enter a descriptive name (e.g. Record1).
As a result, an empty signal window will be displayed:
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Fig.: Empty signal window

Before you can add operands to the signal window you must define the connection that
will be used to establish the contact with the CPU.

For this reason we will first create a new connection.

Brief details on projects:

A single project can be used to maintain several recordings. Each recording is
accommodated in a separate signal window. The different signal windows within a
project can be selected by means of a tree view.

4.2 Creating a new connection

Select menu item "Connections->Maintain connections". The "Maintain connections"
dialog will be displayed.

Fig.: "Maintain connections" dialog
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We are assuming that the PC is connected to the PLC via a serial MPI adapter. This
MPI adapter is connected to COM1 of the PC.

The respective MPI connection details are as follows:

Baud rate RS232: 38400
MPI-address of the S7-SPS: 2
Baud rate in the MPI-ring: 187500

Create a new connection by clicking the button "NEW".
Here you must enter a name. Please choose a meaningful name, for example "MPI
adapter serial, COM1, MPI=2".
Select "S7-RS232" as the connection. The dialog box where you can specify the
settings for the connection "S7-RS232" will be displayed when you click "Next".
Enter the connection details shown above.

Fig.: RS232-MPI-connection settings 

When the S7-controller has been connected to the PC you can verify that a proper
connection can be established with the entered settings. Click on the button "Establish a
test connection".

Click OK to confirm the dialog entries.

The new connection will now be added to the list of existing connections.
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4.3 Adding operands to the signal window

You can add new operands to the signal window by selecting menu item "Signal
window->Add new signal". 
As an alternative you may click on the following button in the tool bar:

Fig.: Tool bar button
 "Add new signal"

The "New signal" dialog box will be displayed.

Here you will now create operands M10.0 to M10.7, MB20 and MW22.

Enter "M10.0" as operand. Type "8" into the field for "Create several operands at the
same time". As the connection you select the connection that you have created above.

Fig.: Operands M10.0 to M10.7 will be added to the signal window

Click the button "Continue".
The dialog "Properties of the signal" will be displayed. Here you can enter additional
settings. In our example we will accept the default settings. Confirm the dialog by
clicking OK.
At this point flags M10.0 to M10.7 are already displayed in the signal window.

Continue by inserting operands "MB20" and "MW22".
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The resulting screen will appear as follows:

Fig.: Signal window with operands

You can change the sequence of the operands. Use the mouse to drag and drop the
title of the respective operand. You can also change the sequence by means of the
dialog "Signal window->Maintain signals" located under the tab "Signals".

4.4 Start (non-cyclic exact) recording

Select menu item "Signal Window->Start recording" to start recording or click on the
red record button (mouse button) just below the menu bar.

Confirm the Start-recording dialog by a click on the first button "Start recording (scan
exact)".

Fig.: "Start recording" dialog, "Scan exact" is selected
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Before the actual recording is started a test is executed to verify that it is possible to
establish a connection with the controller. If this test is successful the recording is
started.

Please read the chapter "Evaluation while recording is active" for additional
information.

4.5 Start cyclic exact recording

Select menu item "Signal Window->Start recording" to start recording or click on the
red record button (mouse button) just below the menu bar.

On the dialog select the type "cyclic exact-dynamic" or "cyclic exact-permanent":

Fig.: Button for for cyclically exact recording

Confirm the Start-recording dialog by a click on the button "Start recording".
The button "Start recording quickly" starts the recording process without any
requests. The dialog "Prepare cyclic exact recording..." will be displayed:

Fig.: "Prepare cyclic exact recording" dialog
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If the PLC is in RUN mode you should first change it to STOP mode by a click on the
button "PLC-STOP".

If you do not want to change the RUN mode of the PLC place a check mark into the tick
box "Upload blocks in mode 'RUN".
The blocks required for this process will created when you click the button "Start
cyclically exact recording".
Now the dialog "Confirm cyclic exact recording" appears:

Fig.: Confirmation of the cyclic exact recording.

You can see all blocks that must be transferred into the PLC. 
After pressing the button "Confirm cyclic exact recording" all blocks will be transferred
into the PLC and the recording process starts.

Important notes on cyclic exact recording:

In order to start a cyclic exact recording OB1 must be modified in the PLC and
additional blocks must be transferred into the PLC. The system should be placed
into STOP mode before this process is started to avoid uncontrollable
RUN-STOP transitions.
Normally the PLC should not change from RUN mode during this process. It will
change to STOP mode only when the following conditions occur:
- the load on the PLC is very high with the result that the maximum cycle time is
exceeded when additional blocks are transferred.
- The recording trigger that you have defined in an STL statement contains
commands that initiate STOP mode.
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4.6 Evaluation while recording is active

Click on the following button if you wish to monitor the recorded values while recording
is active:

Fig.: "Observing signal" button.

The "Observing signal" button displays current PLV values in the signal window.

When "Observing signal" is turned off you can page through the recording area by
means of the following mouse buttons:

Fig.: Mouse buttons to access recording areas

Explanation of these buttons:

1.Next page
2.Previous page
3.Next area
4.Last area
5.Previous area
6.First area
7.Currently displayed area / Number of areas that exist

Explanation of the term "area"

To be able to effectively handle large recording, these are subdivided into areas.
Think of the recording as a printed book with several chapters. A chapter of this book is
comparable with an area.
Lengthy recordings are subdivided into areas. The display indicates the number of
areas in a recording.

If you should change the timescale, the recording in the display will be stretched or
compressed as necessary. For this reason the areas are recalculated as soon as the
timescale changes.
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4.7 Evaluating a recording

You have following evaluation options when a recording has been completed:

Review the recording by means of menu item "Signal window": 
- Next page
- Previous page
- Next Area
- Previous Area
- etc.
Search using "Signal window->Goto":
- Goto Time Position
- Search the recording for a measurement test point (in a specific operand)
- Extended search covering multiple operands
Comparison to other recordings using background signals. See chapter
"Comparisons with background signals"
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5 User interface

5.1 Overview

1.Menu bar
Provides access to all the functions of the program.

2.Tool bar buttons
Here you can issue the most important commands by a simple mouse click.

3.Signal window list
Displays a list of those signal windows that exist in the project that you have
currently selected.

4.Scaling
Here you can change the timescale.

5. Information
Displays important information related to the current signal window.

6.Signal window
This window displays the current recording.
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5.2 Signal window list

The signal window list displays a list of all the signal windows that exist in the current
project.
It is advisable that all the recordings for a specific plant/machine are saved in one
and the same project.
The advantage is that you can access older recordings quickly and easily.
In addition you can also compare the current recording with an earlier recording. The
earlier reference recording is displayed in the background of the current recording.

If you select an entry in the list using the mouse and click the right mouse button the
following entries are displayed in a pop-up menu:

Open Opens the selected signal window.
Close Closes the selected signal window.
Delete Deletes the selected signal window. This is an irrevocable

action.
Copy Copies the selected signal window.
Rename Renames the selected signal window.
New window Generates a new signal window. This is also available in

menu item File->New signal window.
Use as background signal The signal window selected in the tree view window is

inserted as background signal into the currently open
signal window.

Fig.: Signal window list

You can read further details on background signals in the chapter "Comparisons with
background signals".
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5.3 Signal window

The signal window includes the following elements:

1.Absolute timescale with date and time.
2.Relative timescale showing the signal duration with respect to the starting time of

the recording.
3. Information on the operands that are being recorded.
4.The recording of the operands.
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Information on a single signal/operand is displayed on the left:

Fig.: Signal names

1.Maximum value of the signal
2.The value at the position of the time cursor
3.Minimum value of the signal
4.Number format of the signal
5.Selected signals are highlighted by a dark frame.

You can change the arrangement of the signals by using the mouse to "drag and drop"
the different signal boxes:

Fig.: Change the position by a 
"drag-and-drop" operation.

You can move the segment that is displayed (signal) within the current area by means
of the scroll bar (just above the relative timescale):

Fig.: The scroll bar
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The following section describes the term "area":

5.4 Subdividing a recording into areas

To handle large recordings effectively large recordings are subdivided into areas.

Think of the recording as a printed book with several chapters. A chapter of this book is
comparable with an area.
To look through the entire recording, you first select the appropriate area and then you
can review the current area using the scroll bar.

The following signal window shows details:

1.This window displays "Current area/ Total number of areas".
2.You can load the different areas by a click on these buttons.
3.This bar visualizes the subsection of the entire recording that is currently being

displayed at the position of the scroll bar.
4.This is the scroll bar.
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5.5 Scaling

The scaling settings can be used to expand or compress a recording.  
  
If the value for "ms per Pixel" is increased the recording is compressed and the number
of areas is decreased accordingly.  
  
If the value for "ms per Pixel" is decreased the recording is expanded and the number of
areas is increased accordingly.  
  
You can use the slider to adjust the scaling from >0 to 20 ms/Pixel. You can also
specify other values in the input box:

Fig.: Scaling settings

Explanation of the figure above:

1.Slider to adjust the scaling from >0 to 20 ms per Pixel
2.Manual input
3.Current value

The optimum scaling for non-cyclic exact recording is determined automatically.  
You can change the scaling while the recording is active provided that the number of
areas is one.  
The scaling can no longer be altered if the number of areas has increased to two (this is
only possible after the recording has been completed.)
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6 Connections

6.1 What are connections?

Connections provide access to S5- or S-7 controllers. The user generates the required
connections for the entire project. These are available for selection when an operand
will be recorded.

When a new recording is being planned it is possible to define the connection that will
be used to access the controller for each individual operand.
Every connection contains details on how the controller can be accessed.

Fig.: New connection

Fig.: Available settings for 
the "S7-Ethernet" connection
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6.2 Connection types

All possible connection types are described in this section.

6.2.1 Connections of the type "S7-RS232"

This connection type can be used to access an MPI-PC adapter (RS232).   
The serial Baud rate can be adjusted to a value ranging from 19200 to 115200 Baud.  
This connection type can also be used to access an MPI-USB adapter provided that this
presents a virtual COM port.

6.2.2 Connections of the type "S7-Netlink"

This connection type can be used to define access to an MPI- or a Profibus interface.
The Ethernet-protocol is converted to MPI by the MHJ-Netlink. The device is connected
to a network hub/switch or directly to the network adapter in the PC/Notebook by means
of a crossover cable.
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6.2.3 Connections of the type "S7-Netlink-PRO"

With this interface you can connect to MPI- or PROFI-BUS. The NETLink-PRO adapter
converts the ethernet protocols to the MPI/PB-DP protocol. You can connect this device
to a network hub or -switch or directy to the network port on your PC or notebook. In
this case you must use a crossover-patch cable. 
The NETLink-PRO can detect the baudrate on the profibus automatically and can
handle up to 8 connections at the same time.

6.2.4 Connections of the type "S7-Ethernet"

This type of connection can be used when the S-7 controller is equipped with an
Ethernet interface  (directly on the CPU or by an additional Ethernet-CP.)

Advantages of this type of connection:

Fastest type of connection.
The load on the CPU during recording is not very high.

6.2.5 Connection of the type "S7-Simatic Net"

With this connection type existing SIEMENS interfaces (CP5512, CP5611, ...) can be
used. 
You can use this connection, if the SIMATIC® Net driver are installed on your system.
These drivers are installed automatically, if STEP®7 V5.x or Prodave is already
installed. If you install WinPLC7-Analyzer on a SIEMENS PG you can use the onboard
interfaces too.
All settings of these type of connection you must set up within the dialog "Set PG/PC
Interface" in STEP®7 of SIEMENS.
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You can open this settings with the STEP®7 menu item "Options->Set PG/PC
Interface".

The dialog "Set PG/PC Interface"

In WinPLC7-Analyzer you must only setup the MPI/DP adress. Open
connection->Maintain connection and edit the "S7-Simtic-Net" connection:

Simatic Net settings in WinPLC7-Analyzer
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6.2.6 Connections of the type "S7-Simulator"

This type of connection is used to record operands from the software-PLC of
WinSPS-S7 or WinPLC7.
WinSPS-S7 is a programming and simulation package for S7 controllers.

In this case WinSPS-S7 or WinPLC7 must have been started and at the same time set
to simulator mode. 
No additional settings are required.

6.2.7 Connections of the type "S5-RS232"

This connection provides access to a Simatic® S-5 controller via an S-5 connecting
cable (RS232 on a PC, TTY on a PLC.)

6.3 New connection

You can generate a new connection using the "Maintain connections" dialog. Select
menu item "Connections->Maintain connections". 
The connection dialog will be displayed:

Fig.:  "Maintain connections" dialog

Click the "New" button to define a new connection.
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Example: defining a connection for the serial MPI-PC adapter

The following section illustrates how you can define a new connection via a serial
MPI-PC adapter.

1. Click the button "New". The
"New connection" dialog will be
displayed:

2. Select connection "S7-RS232"
and enter a meaningful name for
the connection:

3. Click "Continue"
4. The configuration dialog for the

"S7-RS232" connection will be
displayed.
When you have completed your
entries you should verify the
operation of the new connection
by clicking on "Establish a test
connection".

5. The new connection will appear in
the connection list and it is
available for general use.
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6.4 Using connections

If you add a new operand to the signal window you must always specify the access path
that will be used to load the operand from the PLC.  
In this case you can simply use an existing connection:

Fig.: "Properties of the signal" dialog
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7 Adding operands to the signal window

Add the operands that you wish to monitor to the signal window.

The following operands are supported:

Operand Format
Inputs Ix.y / IBx / IWx / IDx
Outputs Qx.y / QBx / QWx / QDx
Flags Mx.y / MBx / MWx / MDx
Timer Tx
Counter Cx
Peripheral inputs PIBx / PIWx / PIDx
Data DBXx.y / DBBx / DBWx / DBDx

You must open a signal window in order to be able to add operands.  
Select menu item "Signal window->Add new signal" or click the following button:

Fig.: "Add new signal" button

The "New signal" dialog will be displayed:

Fig.: "New signal" dialog
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Description of the input fields:

Fig.: "New signal" dialog.

1.Define the representation: Standard: normal representation, Small: smaller
representation

2.Here you can enter the required operand (e.g. M10.0)
3.Here you must enter the data block (e.g. DB2), provided that the operand is a

data block operand.
4.Here you can enter the number of consecutive operands. For instance, if you

should enter 5 here, then 5 consecutive operands will be inserted into the signal
window.

5.Here you can select the data type. For instance, if you should have entered
"MW10" as the operand, you could select either "INT" or "WORD".

6.Here you must select the respective connection, i.e. the connection that will be
used to read the operand from the PLC.

When you have completed all fields click "Continue". The "Properties of the signal"
dialog will be displayed.  
You can enter additional settings for each operand in this dialog.
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"Properties of the signal" dialog:

"General" tab

The following settings are available in the "General" tab:

Setting Description
Representation Standard or small representation.
Type Here you can define the type of operand.
Color Defines the color that will be used for the

signal in the signal window.
Line width You can use the line width to highlight certain

operands.
Show test points Every test point is represented by a green dot

(Pixel).
Connection The connection determines the communication

path that will be used to read the operand from
the PLC.

Unit Unit (e.g. degrees Celsius). The unit is
displayed on the left side of the signal window.

Commentary Additional commentaries on the operand.
These are only displayed in this dialog.

Symbol The symbol is also displayed in the title of the
operand in the signal window.
You can import an S5 or an S7 symbolic file
using menu item Signal window->Edit
symbols.
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Where operands >=8 bits are concerned, the settings under the "Arithmetic" tab may be
used to customize the test point as required by the display.

"Arithmetic" tab

"Ignore bits" options

These settings can, for instance, be used to neutralize jitter in the low-order bits of
analog signals.

"Shift" options

Here you can shift test point values to the left or to the right by a number of bits.

"Increase/decrease signal" options

A positive value raises the overall signal of the operand.
A negative value lowers the signal.
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"Standardize signal" option

These settings are used to convert an analog value to match a physical area.

For a unipolar signal it is assumed that the analog value will be between 0 and 27648.
For a bipolar signal it is assumed that the analog value lies between -27648 and
27648.
Input fields "lower limit" and "upper limit" define the range to which the analog signal
must be converted.

The analog value is converted according to the following formula:

OUT = [ ((FLOAT (IN) – K1)/(K2–K1)) * (HI_LIM–LO_LIM)] + LO_LIM

K1 and K2 are defined in accordance with the settings (bipolar, unipolar).
HI_LIM is the upper limit, LO_LIM is the lower limit.

7.1 Delete signals

Fig.: "Maintain signals" dialog

Open the "Maintain signals" dialog to delete operands (signals) from the signal window
(menu item Signal window->Maintain signals.)
Select the signals you wish to delete in the "Signals" tab and delete these signals by a
click on the "Delete" button.
Press and hold the SHIFT key to select more than one entry.

You can also delete signals in the signal window. Select the signal and press CTRL and
DEL at the same time.
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Hint:

Use the following procedure to change the color of multiple entries:

1.Select the entries
2.Click the "Multiple edit" button
3.Select a color and select "Apply"
4.Click OK

Proceed in a similar manner to change the connection path for multiple entries.

7.2 Move operands

You can move signals by means of the following buttons in the "Maintain signals"
dialog:

Fig.: Move operands

As an alternative you can also move the operands directly in the signal window:

Fig.: You can change the position
by a "drag-and-drop" operation.
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8 Recording PLC statuses

8.1 Principle of operation of a PLC

Your knowledge about the operation of a PLC is most important when you must
understand a recording.

A PLC always processes individual commands in sequential from. An S7 controller
executes a PLC program as follows:

Execution of an S7 program

OB1 (organization block No. 1) is executed during cyclic processing. It is common that
calls to other blocks are issued from within OB1 (e.g. FC1, FB10).
A cycle of the program has been completed when the OB1 has been processed
completely.  The time required for a cycle is referred to as the cycle time. The cycle
time depends on the size of the program in the PLC and the type of PLC.
Cycle times typically range from 1 to 100 ms.

The maximum limit for the cycle time can be specified to a value of around
200ms. If this limit is exceeded the PLC will be placed in STOP mode.

In addition to cyclic processing the cycle time is affected by other factors:

Alarm controlled program execution (time OBs, cyclic interrupts, false alarms)
Requests to the CPU issued by the programming device or by
WinPLC7-Analyzer

Longer cycle times mean that the reaction time of the PLC to external events
increases.

End of OB1

End of FC1

End of FC2

UC    FC 1 UC    FC 2

OB1 FC1 FC2

Command line 2 Command line 2
Command line 1
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8.2 Types of recordings (cyclic exact / non-cyclic exact)

The software package WinPLC7-Analyzer supports 4 different types of recording:

Scan exact recording (Non-cyclic exact recording)
Cyclically exact recording-dynamic
Cyclically exact recording-permanent
Offline recording (Non-cyclically exact and cyclically exact recording)

The non-cyclic exact recording mode reads the different statuses of the operands at
predetermined timing intervals from the PLC.
Timing intervals depend on the connection type and lie between app. 15ms (e.g. for a
fast TCP-IP connection) and 200ms or more (for slow serial connections).

From these time intervals it is immediately obvious that the normal recording mode is
not suitable for cyclic exact recording. With a typical cycle time of 5ms it is not possible
to capture any change of status that occurs within two cycles.

Truly reliable recording can only be achieved by writing a subroutine to the PLC
program that records the required operands in a data block. Subsequently the contents
of this data block can be polled in a cycle.

Therefore, with cyclic exact recording the program in the PLC must be altered.

The software WinPLC7-Analyzer inserts a "UC FCx" command at the start of OB1 to
issue a call to the subroutine that executes this function.

This does not normally disturb the execution of the original program.

WinPLC7-Analyzer supports three cyclic exact recording types:

Cyclically exact recording-dynamic

In this case data is only available from the PLC, when the status of the operand has
changed.  
Every record (test point) is supplied with a time-stamp.  
This type of recording is suitable for BYTE/WORD/DOUBLE-WORD operands that do
not change in every cycle.

Cyclically exact recording-permanent

In this case the PLC supplies data records after each cycle irrespective of the status of
the operand.  
This recording mode is predominantly suitable for Bit-operands that change in every
cycle.
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Off-line recording

This recording type records the signals as long as free memory available in the defined
data blocks. 

The off-line recording is a modified "cyclic exact dynamic" recording.
You can define a sample rate (polling interval). In this case it is a scan exact recording.
If you define "0" for the sample rate, it is a cyclic exact recording. 

After you start the off-line recording you can disconnect the computer or notebook from
the PLC. While the recording process is active, the PC/notebook must not be connected
to the PLC.
The possible recording time can be from seconds to hours. Depending on how often the
signals change and how the sampling rate is set.

The possible recording time depends on:

Free memory size in the PLC
Sample rate
Number of the signals
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8.3 Non-cyclic exact recording

Non-cyclic exact recording is always employed when the process that must be recorded
is slow (change of process >=0.5 second.)  
Non-cyclic exact recording is probably not required if, for example, the temperature
curve of various heaters should be recorded.

Advantages of "non-cyclic exact" recording:

No changes necessary to the PLC program
It is possible to control the data volume since the polling interval can be adjusted.

Disadvantages of "non-cyclic exact" recording:

Not suitable for applications on faster processors since it is not possible to record
all the relevant statuses without breaks.
The value between two test points is not available.

Preparations for "non-cyclic exact" recording:

The following steps are necessary in order to start non-cyclic exact recording:

1.Open the signal window
2. If you have not entered any operands you must add operands (signals) now.

See chapter "Filling the signal window with operands".
3.Defining recording triggers (see recording trigger chapter)
4.Now you can start the recording: Signal window->Start recording

The dialog "Start recording" will be displayed. 
Select "scan-exact" and define the "polling interval". Then click on the button "Start
recording" in order to start the process.
A test verifies that it is possible to establish a connection with the PLC. If successful, the
dialog is closed and the signal window will be redisplayed.

The default settings mean that the scroll bar is automatically shifted to the right
so that current measurements are always visible.  
If you want to move the scroll bar manually, i.e. if you wish to view earlier
measurements, then you must turn off "Observing signal" using Signal
window->Observing signal off.
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8.4 Cyclic Exact recording - notes

Cyclic exact recording is necessary when very short signals originating from the plant
will be processed by the PLC. Cyclic Exact recording is also required when the status of
an operand changes within a few cycles (e.g. for edge detection).

Advantages of "cyclic exact" recording:

Allows continuous recording of operands.
Can be used to record very fast processes.

Disadvantages of "cyclic exact" recording:

The PLC program in the controller must be modified to implement cyclic exact
recording.
(This process is executed automatically by WinPLC7-Analyzer)
The controller must provide a sufficient amount of free working memory (a
minimum of 2 KB)
The additional routine increases the cycle time (3 ms typically)
High data volume if the status of the recorded operands changes frequently.

We recommend to switch the PLC in STOP mode before you start the cyclic exact
recording.
Only if you know the machine well enough and if you can evaluate the risks, you should
start the cyclic exact recording in "RUN" mode.

What are the risks?

Because of the increase of the cycle time, the PLC can change into the STOP
mode.
If you use a trigger, the STL-trigger code can lead into the STOP mode of the
PLC.
In the PLC can exist an old firmware version that contains bugs. In this case the
additional blocks can cause that the PLC changes to the STOP mode or that a
master reset with restart is necessary.
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8.5 Recording type "cyclic exact permanent"

In this recording type the current values of the signals are stored in every cyclic into a
ring memory.  WinPLC-Analyzer read this ring memory permanently and show the
results on the screen.
The values are saved into the ring memory no matter whether these have changed or
not.
Select this recording type in the dialog "Start recording". After this you can view the
current settings via the button "Settings".

Fig.: Cyclic exact-permanent is selected

With the button "Settings" you can view the current settings to this recording
type:

Fig.: Settings of "cyclic exact-permanent"
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Descriptions:

Setting Description
Search for free FCs from FC-No At which FC number should the search for a

free FC address be started?
Recommendation: 1

Search for free DBs from DB-No At which DB number should the search for a
free DB address be started?
Recommendation: 1

Standard ring memory size in BYTE What size do you wish to assign to the ring
memory that is used for the recording in the
PLC?
Recommendation: 2000

Remaining free memory in the PLC in
BYTE

How much free memory should remain in the
PLC?
Before any additional blocks are transferred a
test verifies that this quantity will not be
exceeded.
Recommendation: 100

Number of ring memory data blocks How many data blocks should be used?
Recommendation: 3

Compress PLC memory Compress the PLC memory before transfer
the blocks?
Recommendation: YES

The record can be started now by pressing the button "Start recording" or  "Start
recording quickly".
No more security queries follow, if the button  "Start recording quickly" is used.
WinPLC-Analyzer determine first, whether the PLC is in the STOP mode. If the PLC is
in RUN mode and the button "Start recording quickly" is not used the following dialog
appears:

Fig.: Prepare cyclic exact recording
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If you want to start the recording, when the PLC is in RUN mode, select the checkbox
"Upload blocks in RUN mode". Then press the button "Start cyclic exact recording".

WinPLC-Analyzer tests now which blocks are in the PLC, whether sufficient working
memory is available and what the current cycle time is.
The necessary blocks are then transferred to the PLC.

After short time the trend of the signals appears on the screen.

The default settings mean that the scroll bar is automatically shifted to the right
so that current measurements are always visible.  
If you want to move the scroll bar manually, i.e. if you wish to view earlier
measurements, then you must turn off "Observing signal" using Signal
window->Observing signal off.
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8.6 Recording type "cyclic exact dynamic"

This recording type checks in every cyclic of the PLC if one of the signal-values is
changed. Only if one of the values is different, all values are stored into the ring
memory.
These recording type is cyclic exact too. But in this type only changed values are stored
into the ring buffer. 
Therefore the amount of data which must be stored, is smaller if the values do not
frequently change.

If the values frequently change, the amount of data will be very huge because
every value comes with a time stamp information. In this case the recording
method "cycle exact permanent" should be used.

WinPLC-Analyzer read this ring memory permanently and show the results on the
screen. Select this recording type in the dialog "Start recording". After this you can view
the current settings via the button "Settings".

Fig.: Cyclic exact-permanent is selected

With the button "Settings" you can view the current settings to this recording
type:

Fig.: Settings of "cyclic exact-dynamic"
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Descriptions of the settings:

Setting Description
Search for free FCs from FC-No At which FC number should the search for a

free FC address be started?
Recommendation: 1

Search for free DBs from DB-No At which DB number should the search for a
free DB address be started?
Recommendation: 1

Standard ring memory size in BYTE What size do you wish to assign to the ring
memory that is used for the recording in the
PLC?
Recommendation: 2000

Remaining free memory in the PLC in
BYTE

How much free memory should remain in the
PLC?
Before any additional blocks are transferred a
test verifies that this quantity will not be
exceeded.
Recommendation: 100

Compress PLC memory Compress the PLC memory before transfer
the blocks?
Recommendation: YES

The record can be started now by pressing the button "Start recording" or  "Start
recording quickly".
No more security queries follow, if the button "Start recording quickly" is used.
WinPLC-Analyzer test first, whether the PLC is in the STOP mode. If the PLC is in RUN
mode and the button "Start recording quickly" is not used the following dialog
appears:

Fig.: Prepare cyclic exact recording
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If you want to start the recording, when the PLC is in RUN mode, select the checkbox
"Upload blocks in RUN mode". Then press the button "Start cyclic exact recording".
WinPLC-Analyzer inspect now which blocks are in the PLC, whether sufficient working
memory is available and what the current cycle time is.
The necessary blocks are then transferred to the PLC.

After short time the trend of the signals appears on the screen.

The default settings mean that the scroll bar is automatically shifted to the right
so that current measurements are always visible.  
If you want to move the scroll bar manually, i.e. if you wish to view earlier
measurements, then you must turn off "Observing signal" using Signal
window->Observing signal off.
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8.7 Recording type "Off-line recording"

The offl-ine recording is a modified "cycle exact dynamic" recording. 
It has two unusual features:

1. It is possible to record "scan exact" and also "cyclic exact". In case of "scan
exact" you must define a polling interval that is greather then "0". If you want
"cyclic exact" you must define as the polling interval "0".

2.The recording values are stored into data blocks within the PLC. If this data
blocks are full with values then the recording will be stopped. While the
recording process the PC must not be connected to the PLC!

If you select "Offline-recording" the edit field "Polling interval ms:" appears:

Fig.: Off-line recording is selected

With the button "Settings" you can view the current settings to this recording
type:

Fig.: Settings of "Off-line recording"
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Descriptions of the settings:

Setting Description
Search for free FCs from FC-No At which FC number should the search for a

free FC address be started?
Recommendation: 1

Search for free DBs from DB-No At which DB number should the search for a
free DB address be started?
Recommendation: 1

Standard ring memory size in BYTE What size do you wish to assign to the ring
memory that is used for the recording in the
PLC?
Recommendation: 2000

Remaining free memory in the PLC in
BYTE

How much free memory should remain in the
PLC?
Before any additional blocks are transferred a
test verifies that this quantity will not be
exceeded.
Recommendation: 100

Number of ring memory data blocks How many data blocks should be used?
Recommendation: 3

Compress PLC memory Compress the PLC memory before transfer
the blocks?
Recommendation: YES

The record can be started now by pressing the button "Start recording" or  "Start
recording quickly".
No more security queries follow, if the button  "Start recording quickly" is used.
It is checked first, whether the PLC is in the STOP mode. If the PLC is in RUN mode
and the button "Start recording quickly" is not used the following dialog appears:

Fig.: Prepare cyclic exact recording
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If you want to start the recording, when the PLC is in RUN mode, select the checkbox
"Upload blocks in RUN mode". Then press the button "Start cyclic exact recording".

WinPLC-Analyzer inspect now which blocks are in the PLC, whether sufficient working
memory is available and what the current cycle time is.
The necessary blocks are then transferred to the PLC.

Now the recording was started in the PLC. 

The signal window gives now information about the internal process.
Select the checkbox "Updating always" to see the current status permanently.

Fig.: Information to the recording process

While the Off-line recording is active, the signal windows looks like in the picuture.

In this state you can disconnect the PC from the PLC and close WinPLC-Analyzer.
If you start WinPLC-Analyzer again and open the same project you can see this
window again.

Now you can load the results with the button "Load offline records now".
Or you can reject the results with the button "Rejecting offline records".

In both cases the original PLC program will be restored.
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9 Conditions

WinPLC7-Analyzer conditions consist of a sequence of STL statements. The result of
the condition is a logical '0' or a logical '1'.

Conditions can be linked to the following actions:

A message can be displayed in the message window
An SMS can be transmitted
It can be linked to the recording trigger

Conditions are a powerful tool since you can use almost all STL statements that are
available in STEP®7. This also means that conditions can become very complex.  
A condition must always have a linear structure, i.e. no calls to other blocks are allowed.

You can define 10 different conditions. In addition, you can also define one condition for
each recording trigger (cyclic exact and not cyclic exact). 
You can define conditions in the tab "Define conditions" that is located in the "Maintain
signals" dialog:

Fig.: The "Maintain signals" dialog is available in menu item 
"Signal window->Maintain signals".
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The STL associated with a condition is processed by an integrated software PLC.

Exceptions to this are conditions related to cyclic exact recording: 
These STL statements are processed by the real PLC.
For this reason it is important that you avoid including STL statements that can not be
processed by the PLC and that would therefore result in the PLC changing to "STOP"
mode.

Please remember the following hints when creating the STL:

Calls to blocks (UC, CC, CALL) are not permitted.
Avoid the use of data blocks, since these can cause "STOP" mode when invalid
bad data addresses are encountered.
Operands whose signals will be recorded by WinPLC7-Analyzer must not be
described in the STL.

9.1 Defining a condition in order to issue a message

You can display a message in the message window (user messages) when a specific
condition has been satisfied.

The following example defines condition No. 1 in the "Maintain signals" dialog.
Open the tab "Define condition" and select Condition 1. Enter the following STL
statements into the text field:

U E 0.0
U E 0.1
U E 0.2
= M 50.0

The following dialog box is displayed:

Fig.: Condition No 1 was defined.
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This means that condition No. 1 is true when the status applied to the three inputs is '1'
(E0.0, E0.1 and E0.2).

It is important that these inputs are entered into the signal window.  
However, flag M50.0 must not be entered here!

In order to send messages you now click on the "Events" tab in the "Maintain signals"
dialog.  
Set the Event-type to "Message" in line 0 and enter "Condition 1" into the respective
field in the "Condition" column:

Fig.: A message was defined

As of now any message that you have defined will be displayed along with the date and
time when the status of the three inputs changes to '1'  
(menu item Signal window->User messages).

9.2 Defining a condition in order to send an SMS

The procedure to send an SMS is similar.
We can use the same condition in order to send an SMS or we can define a new
condition.  
In this example we will use condition No. 1 that was previously defined.  
Set the Event-type to "SMS" in line 1 and enter "Condition 1" into the respective field in
the "Condition" column.

The "Properties" column will display the text:

Target=<insert the target number>,Message=<insert the message>

Enter the required telephone number for "Target=", i.e. the number to which the SMS
must be sent.
Enter the actual short message text next to "Message".
Example:

Target=0172xxxxxx,Message=this is the SMS message text
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The resulting dialog box is displayed as follows:

Fig.: An SMS was defined

The SMS will be dispatched when the status at three inputs is '1' (E0.0, E0.1,E0.2).

Notes on "Send SMS"

A specific modem is required to send "SMS" messages
(see chapter Send SMS)
You must configure and test the sending of SMS messages using menu item
Tools->SMS settings, Send SMS.
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10 Events

Events are used to execute a specific action when the defined event occurs.

The following events are available:

Send SMS, when a specific condition has been satisfied
Add a message to the message window (Signal window->Show user messages)

You can define up to 10 different events.
You can enter the respective settings in the "Events" tab in the "Maintain signals"
dialog:

Fig.: Defining events in the "Maintain signals" dialog

An event is triggered when the respective condition becomes true.

Events provide a powerful tool. They can, for instance, be used to inform support staff
on site or anywhere on the globe by means of a PC when specific conditions occur.

You can turn off events by setting the respective condition to "none".

The previous chapter "Conditions" contains an example on the configuration of an SMS
event or a message event.
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11 Recording trigger

11.1 Time controlled recording trigger

In the "Recording trigger" tab of the "Maintain signals" dialog  you can determine at
which time the recording will be started and at which time the recording will be stopped.

The dialog box below defines the following times to start recording and to stop
recording:

Start recording: 08.03.2005 15:28
Stop recording: 08.03.2005 19:00

Fig.: Recording trigger settings

If you turn on recording by means of menu item Signal window->Start recording the
following status window:

Fig.: Status window for recording
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The status window indicates when the recording will be started.

You can also display this dialog using menu item Tools->Show status
recording-windows.

11.2 Defining a recording trigger using the S7 statement list
(STL)

Recording triggers are intended to reduce the volume of data that will be recorded or to
exclude unwanted data from a recording.

Triggers are always defined as a STL (statement list). These can consist of any valid
STEP®7 commands.

Here we distinguish:

Recording triggers for non-cyclic exact recording

and

Recording triggers for cyclic exact recording

In case of a non-cyclic exact recording the STL statements are processed by the
integrated software PLC.
During cyclic exact recording the STL statements are processed by the real PLC.

For cyclic exact recording it is therefore important to ensure that you do not use
statements that could result in the PLC going to STOP mode.

To play it safe you should only use STL commands that perform read operations and
that you only use operands that exist in the PLC.
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Cyclic exact recording triggers

Example of a recording trigger used for cyclic exact recording:

   U E 0.0
   U M 4.4
   U M 50.2
   O
   U E 10.2
   U E 10.3
   BEB

These STL statements will only read from operands. For this reason this recording
trigger and related statements will not place the CPU into STOP mode.
The STL must be defined within the condition "Trigger -cyclically exact-":

Fig.: Defining Trigger -cyclically exact-

Please note: 
If you should write to an operand (e.g. using a set command) here you would also
change the status of the respective operand in the real PLC.

For the cyclic exact trigger it is important that the STL ends with the command
"BEB" (BEC).

Please adhere to the following rules when you create the STL:

You can only create a linear program, i.e. calls statements using the commands
UC, CC, CALL are not permitted.
Avoid statements that could change the status of operands.
Avoid statements that could result in the PLC going to STOP mode (e.g. access
to non-existent data blocks)
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Non-cyclic exact recording triggers

The STL statements of this recording mode access the internal software PLC and not
the real PLC.

When recording is active, operand signals are transferred from the real PLC into the
software PLC.
For this reason you should only read those operands that are recorded in the signal
window.

Any operand recorded in the signal window must not be altered. If you do not comply
with this rule, an error message will be issued and recording will not be started.

The STL must be defined within the condition Trigger -not cyclically exact-:

Fig.: Defining the trigger for not cyclically exact recording

Please adhere to the following rules when you create the STL:

You can only create a linear program, i.e. calls statements using the commands
UC, CC, CALL are not permitted.
Operands appearing in the signal window must never be altered.
Avoid statements that could result in the PLC going to STOP mode (e.g. access
to non-existent data blocks). In this case an error message will be issued and
recording will not be started.
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11.3 Activating the STL-recording trigger

Activate the STL trigger in the "Recording trigger" tab by means of the following check
mark:

Fig.: Activating the STL-recording trigger.

The STL defined in the "Define conditions" will only be used when you have activated
this check mark.
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12 Snapshots

12.1 What are snapshots?

Snapshots are images of operand ranges at a particular time. One snapshot can
contain whole and different operand areas.

Example:
One snapshot could consist:

MB0 to MB100
IB10 to IB 20
QB 124 bis QB 134

A snapshot is suitable, if you need additional information in a specific machine
position.

After the scan-exact recording you can examine additionial to the signal trends the
operands in the snapshot.

If you have defined a snapshot, you can use this in the scan exact recording. It is not
possible to use snapshots in cyclic exact recording.

12.2 Define snapshots

You can define snapshots with the tabsheet "Define snapshot" in the dialog "Maintain
signals".

Fig.: Empty table
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To create a new range, press the button "New":

Fig.: Define a range of operands

In this dialog you can define the type of operand, the start address and the number of
bytes.

You can use the following types of operands:

Inputs and Outputs
Bit memory (M)
Timer
Counter
Data of data blocks
Peripheral outputs

With the different buttons in this tabsheet you can define and edit multiple operand
areas:

Button Description
Edit Edit the selected rage.
New Create a new range in the table.
Delete Delete the selected range.
Delete table Delete the complete table.
Load Load a snapshot definition from a file.
Save Save the current table in the default file name.
Save as ... Save the current table in a specific file name.
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Fig.: example for a range definition

In the picture you can see three areas (ranges). At the bottom of the table you can see
the size of the snapshot in bytes.

Consider that it takes some time to load the operand ranges from the PLC. In this short
time the normal recording is stopped.

12.3 Define the event for the snapshot

To activate the snapshot mechanism you must define a snapshot event.
At first you must write STL lines to define the trigger. This can be done in the tabsheet
"Define condition".

In this example the snapshot should be created, when the operand M10.0 have the
status '1'.
The short STL program for this is:

A  M  10.0
=  Q 100.0

Important thing is, that the operand "M10.0" exists as signal in the signal window. Only
in this case the status of the operand is known.
The last line must always be a assignment to a output- or bit memory operand. 
You must use a operand that not exists  in the signal window.

This STL-program is executed from a software PLC (not from the real PLC)!
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Fig.: Condition1 is finished

Now we switch to the tabsheet "Events" and edit the event with number 0:

Fig.: Event 0 is changed to "Snapshot" and to "Condition1".

In the picture you can see that the "Event 0" have now the event type "Snapshot".
The condition was changed to "Condition1". In the field "settings" you can place any
comments.

This settings causes now that the snapshot is stored, if the "condition1" is true (M10.0 is
'1').

12.4 Start recording and activate snapshots

Fig.: Dialog "Start recording"

Select the recording type "Scan exact" and select the checkbox "Activate snapshots".

Now you can start the recording by pressing the button "Start recording".
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12.5 Evalute snapshots

You can see also the saved snapshots as yellow labels in the signal window.

Bild: Snapshot labels in the signal window

If you make a double click to a label the tabsheet "Evaluate snapshots" appears.

Bild: Tabsheet "Evaluate snapshot"

Now you can use this table like a status variable table. You can insert operands from
your snapshots into the table: Select the colnum "Operand" and type in "MB5". When
the MB5 belong to the snapshot, the value of this operand appears.

Example: 
The snapshot consists of the following operand ranges:

MB0 - MB9
IB124 - IB127
QB128 - QB131
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Then you can enter the following operands into the table:

Bild: Tabsheet "Evaluate snapshot"

There exists two methods to evalutate snapshots:

1.Double-Click on a snapshot-label in the signal window, then only this snapshot
appears in the left side of the tabsheet "Evaluate snapshots".

2.Open the dialog "Maintain signals" over the menu item "Signal window->Maintain
signals". Select the tab-sheet "Evaluate snapshots". In this case all snapshots  
will appear in the left side. If you change the selection on the left side, you can
see on the right side the current values of the operands.
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13 Evaluation of recordings

When a recording has been completed you can use various tools to evaluate the result.

The most important properties of a recording are:

1.Number of signals.
In the figure below this amounts to 220303 test points.

2.Timescale.
In this figure this amounts to 12 hours 56 minutes and 57 seconds.

3.Current scaling.
In this figure this is 41 ms pie Pixel.

4.Area subdivision of the recording.
In this figure this amounts to a total of 38 areas. The current area is 1.

Fig.: Signal window with a recording

Note: 
Chapter "User interface" contains a detailed explanation of the term area.
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13.1 Search for test points

You can search for specific test points in your recording using menu item "Signal
window->Goto":

Search for a specific date and time
Search for a time position (offset)
Search for the actual value of a specific operand
Search for the test point sequence of a specific operand
Search all operands 

13.2 Search for date and time or an offset

This search relates to a single operand in the signal window. For this reason you must
first select the operand in the signal window.

Open menu item "Signal window->Goto". In the "Goto time position" tab you can search
for a specific time position:

Fig.: Search for an absolute or a relative time position

Click the "Search" button to jump to the respective position in the signal window.
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13.3 Search for the actual value of a specific operand

This search relates to a single operand in the signal window. For this reason you must
first select the operand in the signal window.

Open menu item "Signal window->Goto". In the "Search for measurement" tab you can
search for the required actual value:

Fig.: Search for actual values

The "Search" button jumps to the next match in the signal window.
The "Count" button determines how many test points match the search expression.

The field "Search for test point sequence" issues a search for a specific sequence of
actual values. Meaningful results are only produced when you use binary operands.
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13.4 Extended search (covering all operands)

The extended search searches several operands located in the signal window.  
You can specify the respective conditions in the "Extended search" tab:

a
a
a
a
a
a
a
a
a
a
a
a
a
a
a
a
z

Fig.: Extended search (not yet specified) Fig.: This search will include two operands.

A click on "Add" inserts operands from the signal window that you wish to include in the
search.

When you click "Search" any position in the signal window where a match is detected
will be selected.
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13.5 Measuring time

A simple and quick procedure can be used to measure times.   
In order to determine a specific time you first position the time cursor (refer to Fig. 1.)
Press the right mouse key and select menu item Show or move difference cursor.
The difference cursor appears. You can move it by means of the mouse. 
Move the mouse to the 2nd location and click the left mouse key.

The time interval will be displayed at the bottom left. The frequency (1.0 divided by the
time interval) is also displayed in brackets.

1. Time cursor
2. Menu item difference cursor

Here the difference cursor gas been moved.
The panel at the right shows

the respective interval.

To hide the difference cursor, press the right mouse key and select menu item Hide
difference cursor.
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13.6 Creating comment fields

You can specify comment fields to include labels in the signal window.

Procedure to create a new comment field:
Move the mouse pointer to the position where you want to create the comment field.
Click the right mouse button to display the context menu. Select new comment field.  

The comment field is displayed on-screen. Double-click the comment to change text
and color.

Fig.: New comment field

13.7 Goto comment field

You can also use comment fields as bookmarks.  
Use comment fields to identify interesting sections of the record. Subsequently you can
access the "Goto comment field" dialog using the context menu.  
This displays a list with all the comment fields contained in the signal window. Now you
can select the field you want to jump to.

Fig.: Goto comment field dialog
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13.8 Evaluations of the system messages

The analyzer log important events as system messages. You can view the system
messages with menu item "Signal window->Show system messages".

Following events are logged as system messages:

Recording start
Recording end
Communication errors
PLC switch to STOP mode (new in version 2)
PLC switch to RUN mode (new in version 2)

If the PLC switch to STOP mode, the I stack and the B stack is logged in a file.
To view the I stack select a entry in the system message list with a STOP event and
press the button "Show I stack".

So you can examine the reason of the STOP event after recording.
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14 Comparisons with background signals

14.1 What are background signals?

Background signals are recordings that are included as background with the current
record.

In this manner it is possible to graphically compare new recordings with old recordings.
For some machines it makes sense to prepare a recording of the installation while it is
operating properly in order to compare this reference recording with a current
recording when failures occur. 
On complicated installations a comparison of the two recordings can be used to quickly
locate the source of the problem.

The default color for the background signal is yellow. You can change this color using
menu item "Tools->Color settings".

Example of the representation including a background signal:

Fig.: Signal displayed with background signal

On the left you can see the measurement at the time of the time cursor. The value of
the background signal is shown in brackets.

Applications for background signals

Comparing current recordings to earlier recordings
Verifying that all the clock cycles of the machine match the times recorded
earlier. This can be used to implement effective quality control measures.
Simplification of the comparison of new recordings with the recordings that were
made when the installation was commissioned when evidence is required.
Quick recognition of mechanical wear and tear that affects the time response of
the installation.
Quick and simple verification of control optimizations.
Location of errors that are caused by altered time responses of processes.
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14.2 Displaying background signals

Procedure to compare a current recording with an earlier recording:

1.Open the signal window containing the current recording.
2.Search and select the recording for the comparison in the signal window list.
3.Click the right mouse key to display the context menu.
4.Select menu item "Use as background signal".

Fig.: Context menu with the entry
Use as background signal

After verification the selected recording is inserted as the background signal into the
current window.  
The default color for the background signal is yellow.

You can also convert the current recording to a background signal:
select menu item Tools->Background signals->Move signals to background

14.3 Deleting background signals

Select menu item Tools->Background signals->Delete background signals to delete
a background signal.
When you confirm that you wish to continue the background signal will be deleted.
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15 Send SMS (Short Message Service)

15.1 Which modems are supported?

SMS messages can only be transmitted with certain modems.

A list of modems is available in the "SMS settings, Send SMS" dialog. The system
supports all the modems that are contained in this list:

Fig.: Send SMS settings

Note:
Grayed out settings are not required for the selected modem.
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15.2 Configuration

You must enter certain settings in the "SMS settings,..." dialog before the system can
send SMS messages.

Select menu item Tools->SMS settings, Send SMS to display this dialog.

Fig.: SMS Settings, Send SMS dialog

The following settings are available:

Setting Explanation
Connected modem A list of modems that are available

for use.
Port Enter the serial port where the

modem is connected.
Provider Select the provider for the target

number.
Country code Enter the country code for the

telephone number that will be used
to send SMSs

City code Enter the city code for the telephone
number that will be send SMSs.

Own number Enter the local telephone number  
(without city or country code) for the
telephone number that will be send
SMSs.
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15.3 Test SMS

Fig.: Send a test SMS

You can send a test SMS from the "Send SMS" tab. 
You should do this at least once to test your settings.
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15.4 Sending an SMS while a recording is active

An event can trigger sending of an SMS while a recording is active.  
You can define events in Signal window->Maintain signals.

The respective event is triggered when a condition should become "true" while a
recording is active. If this event is an SMS event the SMS is transmitted.

The chapter on conditions contains details on the configuration of an event in order to
send an SMS.

Fig.: Events can be configured in the "Maintain signals" dialog.
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16 The most common questions

Which is the fastest communication interface for WinPLC7-Analyzer?
A connection to an Ethernet-CP (or Ethernet on board) is the fastest communication
link.
In WinPLC7-Analyzer this connection is called S7-Ethernet.

By how many milliseconds does the cycle time increase for cyclic exact
recording?
This depends on how many operands are recorded and which type of S7-CPU is being
employed.
This is generally app. 3ms.

How much free memory must remain in the PLC to ensure that recording is
possible?
At least 1600 Byte of working memory are required.
At least 2300 Byte of load memory are required.

How can a new recording be started without overwriting the earlier recording?
Start by creating a copy of the record and then use this copy for the new recording.
Select an entry in the signal window list (at the left edge of the screen) and press the
right mouse key. Then you select 'Copy'.

Can i use my SIEMENS interface CP5512 or CP5611 with WinPLC7-Analyzer?
Yes, with version 2 of WinPLC7-Analyzer

WinPLC-Analyzer  User Manual  English

83

E
ng

lis
h


